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SUMMARY AND SCOPE 

This tutorial will outline the use of MIMObit's RadMap application.  Radmap solves the 
scenario of a Tx radio and a distribution of Rx radios around it.  It calculates quantities such as 
Signal power, Interference, SINR, Capacity, etc. at each Rx radio.  The example here will have 
a 4-port antenna system at the Tx and the same 2-port antenna system on each and all the Rx 
radios. 

The tutorial will also so how, after the 4x2 problem is solved, with minimal editing the 
scenario could be rendered 2x2 and solved again.  The performance of these two scenarios will 
then be compared in a straightforward manner in terms of the statistical properties of their 
Capacity. 

 

 

 

1 RADMAP TUTORIAL 

The scenario we will investigate includes  

frequency:  2.4-2.5 GHz 
Tx:  a 4-port antenna (to be downloaded from MIMObit's Antenna Libraries). 
Rx: a 16x16 distribution of 256 Rx radios, all with the same 2-port antenna (to be 

downloaded from MIMObit's Antenna Libraries). 
prop model: IEEE 802.11 TGn-B 
Interference: Α λ/2 dipole 75 m away from the signal Tx radio
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Step 1.1. Start MIMObit from the desktop shortcut and select the "New..." project. 

 

Figure 1.1 Select "New..." from MIMObit's Welcome screen 

Step 1.2. Select/Create the location of the new working directory.   

 

Figure 1.2 MIMObit's Config file GUI.  This window comes up with the default values of certain 
of MIMObit's input variables.  Familiarize yourself with the variables and their 
functionality (they are all explained in the manual).  Click "OK" to save this and 
overwrite its copy to proceed. 
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Step 1.3. The Main MIMObit GUI appears with the default horizontal plane (x-y plane) grid.   

 

Figure 1.3 MIMObit's Main GUI.  Notice the "Status Window".  It is split in two parts.  The 
bottom, in red, provided error and warning messages.  The top, in green, provides 
status information.  It is helpful to read these message as they appear.  Familiarize 
yourself with the shortcut menu icons as they can save you a few clicks. 

 

Step 1.4. We will change the scale to 200m x 200m and place two Tx radios on it.  A signal Tx 
radio at the origin and an Interference Tx radio 75 m to its left 

  

Figure 1.4 Change the x-y limits of the viewable space 
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Step 1.5. Download from the Antenna Library two antennas (their lab files).  The 4X_dipooles 
and the 2V_dipoles have been used in this tutorial.  They represent 2 pairs of ±45º 
dipoles and 2 vertically polarized dipoles, respectively, tuned at 2450MHz. 

 

Figure 1.5 Open the Utilities/Libraries/Antennas/WiFi_2450MHz library files and right-click on 
the 4X_dipoles and 2V_dipoles lab files to import them into the working directory.  
Read the pdf document in the same location to learn about those antennas.  They 
have been simulated with MIMObit's MoM code (see the manual) and their 
associated MoMdipolesinfo.dat files are also included in the library so that the user 
can easily modify them. 

 

Step 1.6. Create a New Transmitter radio file (select individual transmitters) 

 

Figure 1.6 From the MIMObit menu bar, select "New Transmitters File/Individual Transmitters..." 
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Step 1.7. In the "Set Transmitter Parameters" GUI that appears, enter 2 for the "Number of Tx 
Radios" and start setting the characteristics of these two radios.  Select the 1st radio 
at the origin (i.e. x=y=0) and leave the default of "Frequency Flat" for its power mask.  
Under the "Pattern id", select "load file" and use the 4X_dipoles_2450MHz. 

 

Figure 1.7 The GUI to "Set Transmitter Radio Parameters" 

When you finish with the properties of the first Tx Radio, "Save Transmitter".  The "Tx Radio 
id" index in the gray box will increase by 1 to "2".   

 

 

Step 1.8. Set the properties of the second radio also, selecting its type to be "Interference" and 
a /2 dipole as a pattern from the Pattern id drop-down options.   

 

Figure 1.8 The GUI to "Set Transmitter Radio Parameters" 
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At the Temporal section, from the 
dropdown menu select "Define time 
function..." and at the f(t) field that 
appears, enter a time function 
indicating a sequence of 
"ON"/"OFF" states.  E.g. 
0.5*(1+sign(sin(0.1+2*t))).  No 
spaces are allowed in the definition 
of the function.  Any Matlab function 
syntax is acceptable.  Upon 
completion, "Save Transmitter" and 
then "Save & Load" to save this set 
of Tx radios and load their file(s) 
into MIMObit's memory.  Note that 
this operation will save all the 
information you have entered in 
several files.  The interested user 

may want to use Windows Explorer to monitor these by looking at the list of files in the working 
directory. 

 

 

Step 1.9. Click "Save Transmitter Radio" and "Save File" to save the Tx Radio file(s).   

 

Figure 1.9 Upon saving the Tx file, the two Tx radios will appear in the MIMObit GUI.  The 
Signal Tx radio is indicated with a dark blue color and has a negative sign in front of 
its id.  The Interference Tx radio has a light blue color. 
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Step 1.10. Create a New Receiver Radio File (select Distributed Receivers...) 

 

Figure 1.10 From the MIMObit menu bar, select "New Receivers File/Distributed Receivers..." 

 

Step 1.11. Specify the Rx Radio distribution (i.e. their locations) 

 

Figure 1.11 Start creating a distribution of Rx radios 
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Step 1.12. Select Pattern for the Rx Radios.  At this point, ALL the Rx Radios will have the 
same pattern.  This option is suitable for large numbers of Rx radios where you don't 
want to specify their characteristics one by one.  You can edit individual Rx radios 
later.  At the "Pattern id" drop down menu select the "Load Patter..." option and 
identify the 2V_dipoles_2450MHz.lab file that you downloaded earlier from the 
MIMObit Antenna Library.  "Save & Load" to save the name of the Rx Radios file and 
load it into MIMObit. 

 

Figure 1.12 Start creating a distribution of Rx radios 

 

Upon completing the "Save & 
Load", the Rx radios will appear in the 
MIMObit GUI as shown in the picture 
here.  Depending on the graphics card 
of your computer, a large number of 
items in the MIMObit GUI may slow 
down its response.  After inspecting 
your Rx radio distribution, it is 
recommended that you Click on the 
dropdown menu at the upper right and 
select "Show Tx Only".   
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Step 1.13. Select the IEEE 802.11 TGn-B propagation model. 

 

Figure 1.13 Prop model selection 

This particular model consists of two clusters of power.  The first cluster has 5 rays (plane 
waves) in it and the second has 7 rays.  See the manual for a more detailed description as well 
as propagation model applicability. 
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Step 1.14. Set the frequency points over which you want MIMObit simulations.  Any Matlab 
syntax would work.  In the figure below we select three points, 2400, 2450 and 2500 
MHz.  Click "Test" to see all the individual frequency points that your description 
renders.  "Save & Load" the frequency file. 

 

Figure 1.14 Select the frequency points for MIMObit simulations 

 

Step 1.15. Select the time instances over which to simulate.  Any Matlab syntax will work.  Here 
we use 0:1:5 which translates into the time instances being 0, 1, 2, 3, 4 and 5 sec.  
Click "Save & Load" and save the time file. 

 

Figure 1.15 Time instance selection 
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Step 1.16. Make sure that the "RadMap" 
simulation type is selected (it is 
shown in the bottom right corner of 
the MIMObit GUI.  If a simulation 
type other than RadMap is shown, 
go under the "Simulation" menu of 
the MIMObit GUI, and select 
RadMap as the simulation type.  
Click "SIMULATE" to start the simulation, pay attention to the messages in the status 
window and wait. 

 

Figure 1.16 RadMap Simulation.   

MIMObit simulations can be very fast or very long, depending on the size of the problem.  
The user has the option of setting a "checkpoint" to avoid running a very long simulation 
unintentionally.  See the manual for turning this checkpoint ON/OFF and how to change its 
threshold.  The default is 10 minutes (see the "Simulation Time" option in the Config file, Figure 
1.2 above).  For the problem in this tutorial and for the computer used, the simulation (without 
the temporal behavior part) is estimated to be 10.2 minutes, so the user has the option to 
"PROCEED" or "ABORT".  Select "PROCEED" to let MIMObit finish the simulations.  Obviously 
faster/slower computers would run this tutorial problem in less/more time. 
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Step 1.17. Upon completion of the simulations, the "Plot RadMap Results" GUI appears with all 
its option to visualize the results as well as options to further post process the results 
for new, derivative, results.  Familiarize yourself with the options available and check 
the manual for more details. 

 

Figure 1.17 The "Plot RadMap Results" GUI and  
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Step 1.18. Click "RF Radio Map" to see the Total RF power in the environment.  Change the 
time instant to t=2 sec and repeat.  You can select to view different quantities such 
as Signal only, Interference only as well as Total power.  You can also turn the 
"Animation" ON and save an animation gif file. 

  

Figure 1.18 Total RF Power in the environment (i.e. as received by the 16x16 grid of Rx radios. 

 

 

Step 1.19. Select the time instance t=0, leave the "Quantity" the default "Open Loop 
Mismatched Capacity" (OLMISMCAP) and click "PDF/CDF" for the pdf and cdf plots.  
Change the time instance and see changes in the Capacity pdf/cdf.  This is because 
the Interferer Radio (Tx Radio # 2) was given a temporal behavior of switching ON 
and OFF at Step 1.8.  When OFF, the resultant SINR is higher resulting in a higher 
capacity.  Use the "Add-on Legend" field to indicate in the relevant plots that the 
results pertain to Pav=1.0W. 

  

Figure 1.19 PDF and CDF plots of the Open Loop Mismatched Capacity at t=0 
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Step 1.20. Change the total available power of the Signal Tx (i.e. Tx radio # -1) to 0.5W and 
"Update Results".   

 

Figure 1.20 Become familiar with the plotting and post-processing options of the "Plot RadMap 
Results" GUI.  Here, change the total available power of the signal Tx radio to 0.5W 
and compare the capacity results with that of 1W. 
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Step 1.21. Use the "Add-on Legend" field to indicate in the new plots that the new results 
pertain to Pav=0.5W.  Select the "Plot on current Fig" to plot the new results in the 
same figure as the one that is open (i.e. the Pav=1.0W results).  First plot the Open 
Loop Mismatched Capacity.  Then select the "Closed Loop Waterfilling Capacity" 
(CLWFCAP) and hit "PDF/CDF" again. 

  

Figure 1.21 PDF and CDF plots of Open Loop and Closed Loop Waterfilling capacities. 

Notice that when the Pav was reduced by 3dB from 1W to 0.5 Watts, the 
corresponding mean value of the Open Loop Capacity was reduced.  However, the 
Closed Loop Waterfilling capacity with Pav=0.5W, as the theoretically maximum 
capacity possible, was slightly better than even the Pav=1W Open Loop capacity.  
This of course, is due to the fact that in the Open Loop mode, the Tx radio does not 
now anything about the channel and blindly allocates all its available power equally 
amongst the available antennas.  In the Closed Loop case, however, the Tx knows 
the channel and can use different algorithms to maximize the capacity.  Waterfilling 
is the algorithm that theoretically maximizes the capacity, albeit at the expense of 
complexity. 

 

Step 1.22. Under the "File" menu of the MIMObit GUI, select "Save project" to save all the 
active files pertaining to this project in a given directory (to be named by you).  In 
addition to saving this project for future reference, this will allow you to use the "Load 
project..." option from the File menu in the future and perform additional simulation 
experiments as you see fit. 
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2 ADDITIONAL EXPERIMENTS 

 

NOTE (COMPARING DIFFERENT ANTENNA SYSTEMS):  Without leaving the RadMap 
application, you can open the "Edit Tx" menu and change the antenna system used for the 
signal Tx radio.  For example, instead of the 4X_dipoles_2450MHz you could download the 
4V_dipoles_2450.lab file from the Antennas Library (4V describes 4 Vertically polarized dipoles 
-see the documentation in the Antennas Library).  You can then re-simulate and save the results 
under a different filename.  When the "Plot RadMap Results" GUI comes up you can plot the 
results of the 4V_dipoles_2450 first.  Then, you can click "Load H" to load the *Htotalresults.dat 
file from a different (any different RadMap simulation) and plot them on the same figure(s). 

 

 

You can experiment with several additional ideas using this project as a base.  For example, 
you can: 

 Change the excitation vector and see how the signal received by the Rx radios changes 
from location to location as a result.  This is because you could, for example, put in a 
progressive phase on the Tx radio antennas which in effect will result in some sort of beam 
steering. 

 Under the Antennas menu use PlotLab to investigate the properties of the 4X-
dipoles_2450MHz and/or the 2V_dipoles_2450MHz antenna systems. 

 Under the "Edit Transmitters" menu, go to Tx Radio id # -1 and select a different antenna 
systems for it (e.g. select the 2V_dipoles_2450MHz.lab file, same as the Rx radios).  Save 
the file under a new name and rerun the RadMap simulation (by simply clicking 
"SIMULATE").  Confirm "PROCEED" to continue with the simulations, if the threshold CPU 
time estimate is exceeded, and wait for the "Plot RadMap Results" GUI.  Plot any of the 
results you want. 

 Under the "Simulation" menu, select "Simulation Type" and then "PropStats".  Click 
"SIMULATE" to run the PropStats simulation.   MIMObit will ask you to identify a single Rx 
Radio out of your Rx Radio distribution.  This is because PropStats will focus on the 
simulation of the signal received by a single radio when the propagation environment 
changes randomly Nprop times, where Nprop=10 by default.  Nprop can be changed in the config 
file to something that would render more statistically robust results (e.g. Nprop=100).  Use 
"Edit from the MIMObit GUI and then "Edit Loaded Configuration File..." to change Nprop. 
 
 
 


